
Introduction to FEA and SOLIDWORKS Simulation
In this chapter, the following topics will be discussed:

•  Introduction to SOLIDWORKS Simulation
•  Introduction to Finite Element Analysis (FEA)
•  Working with Different Phases of FEA 
•  Important Terms and Definitions used in FEA
•  Different Application Areas of FEA
•  Installing SOLIDWORKS Simulation
•  Getting Started with SOLIDWORKS Simulation
•  Identifying SOLIDWORKS Documents
•  Adding CommandManager Tabs
•  Invoking SOLIDWORKS Simulation

Welcome to the world of Computer Aided Engineering (CAE) with SOLIDWORKS Simulation.  
SOLIDWORKS Simulation is a product of Dassault Systemes SOLIDWORKS Corp., one of the biggest 
technology providers for engineering software solutions that lets you create, simulate, publish, and 
manage data. By providing advanced analysis techniques, SOLIDWORKS Simulation helps engineers 
to optimize performance of products and allows them to cut prototyping cost, create better and safer 
products, and save time as well as development costs.

CHAPTER

1
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Introduction to SOLIDWORKS Simulation
SOLIDWORKS Simulation is a Finite Element Analysis tool which enables critical engineering 
decisions to be made early on in the design process. With this software, engineers have the tools to 
easily study the initial design and predict the performance of the complete digital prototype. The 
automatic meshing tools of this software generate mesh with high-quality elements on the first pass. 
It also enables engineers to directly edit the mesh for accurate placement of loads and constraints, 
and simplifies geometry by using its powerful modeling capabilities. SOLIDWORKS Simulation makes 
it possible to quickly validate the design concepts before resources are invested in significant design 
changes or new products.

SOLIDWORKS Simulation provides a wide range of linear and non-linear materials that allow a 
better understanding of the real-world behavior of products and provides engineers the knowledge 
of how a product will perform in the real-world environment.

SOLIDWORKS Simulation is fully integrated with SOLIDWORKS and supports efficient workflow in 
today’s multi-CAD environment by providing direct geometry exchange with other CAD applications 
such as Creo Parametric, CATIA V5, NX (Unigraphic), Solid Edge, Autodesk Inventor, and so on. 
It makes iterative design change without redefining material, loads, constraints, or other simulation 
data when working with the native CAD format. You can also import geometry of universal file 
formats such as ACIS®, IGES, STEP, and STL for solid models as well as the CDL, DXF™, and IGES 
for wireframe models.

SOLIDWORKS Simulation provides a broad range of simulation tools to perform various types of 
analysis, which helps engineers to bring product performance knowledge into the early stages of 
the design cycle. 

The various types of analysis that can be carried out by using SOLIDWORKS Simulation are discussed 
below. 

Linear Static Analysis
Linear static analysis is used for calculating displacement, strain, stress, and reaction forces of an 
object under the impact of applied load. In the linear static analysis, the material properties of the 
object are assumed to behave linearly under the impact of applied load and the object returns to 
its original configuration once the load has been removed. Also, the load is assumed to be constant 
and does not vary with respect to time. Besides, in this analysis, the displacement is assumed to be 
smaller due to the applied load.  

Frequency Analysis
Frequency analysis is used for calculating the natural or resonant frequencies and the associated 
mode shapes of a structure. Natural or resonant frequency is the frequency of an object at which it 
vibrates when disturbed from its rest position. By knowing the natural frequencies of an object, you 
can ensure that the actual operating frequency of the object will not coincide with any of its natural 
frequencies to avoid the failure of the object due to resonance.
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Buckling Analysis
Buckling analysis is used for calculating the buckling load, which is also known as the critical load, 
when the model can start buckling, even if the maximum stress developed in the model is within the 
yield strength of the material. Buckling refers to a larger deformation occurring due to axial loads 
acting on the structures such as long slender columns and thin sheet components. 

Thermal Analysis
Thermal analysis is used for calculating temperature distribution in an object as a result of conduction, 
convention, and radiation. It helps to avoid over-heating and melting conditions. In addition to 
calculating temperature distribution, this analysis also determines the related thermal quantities such 
as thermal distribution, amount of heat loss and gain, thermal gradients, and thermal fluxes.

Drop Test Analysis
Drop test analysis is used for calculating the response of an object when it is dropped on a rigid or 
flexible floor.

Fatigue Analysis
Fatigue analysis is used for calculating the stress at which an object fails, when it undergoes repeated 
loading and unloading which weakens the object after a period of time and causes failure of the object 
even at a stress value within the allowable stress limits. You can also predict the total life and total 
damage of the object due to repeated loading and unloading.

Non-linear Analysis
Non-linear analysis is used for calculating displacement, strain, stress, and reaction forces of the 
non-linear mechanical problems which includes large deformation, plasticity, creep and so on. In 
this analysis, the material properties of the object are assumed to exceed its elastic region under the 
impact of applied load and experience plastic deformation. This means that the object will not return 
to its original configuration even after removing the applied load. Non-linear analysis can undergo 
static analysis (applied load or field conditions do not vary with respect to time) and dynamic analysis 
(applied load or field conditions vary with respect to time).

Linear Dynamic Analysis
Linear dynamic analysis is used for calculating the response of an object to a dynamic loading 
environment. In this analysis, the load or boundary conditions vary with time due to the sudden 
loading. Also, the material of the object is assumed to behave linearly under the impact of the applied 
load and that it will return to its original shape once the load has been removed. This analysis includes 
oscillating loads, impacts, collisions, and random loads. The linear dynamic analysis is classified into 
four main categories which are discussed below. 

Modal time history
The modal time history analysis is used for analyzing the response to load as the function of time.

Harmonic
The harmonic analysis is used for analyzing the response of an object to harmonically time varying 
loads.  
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Random vibration
The random vibration analysis is used for calculating maximum stresses due to the vibration which 
occurs in response to the non-deterministic loads, which include loads generated on the wheel of a 
car traveling on a rough road, base accelerations generated by earthquakes, pressure generated by 
air turbulence, and other similar types of load. In the random vibration analysis, the input is provided 
to the system is in the form of ‘Power Spectral Density (PSD)’, which is represented as vibration 
frequencies.

Response Spectrum 
The Response spectrum analysis is used for calculating the response of a structure which undergoes 
sudden forces or shocks due to earthquakes, wind loads, ocean wave loads and so on. It is also 
assumed that the shocks or forces occur at an area which is fixed.

Pressure Vessel Design Analysis
The pressure vessel design analysis is used for analyzing pressure vessels. In this analysis, you can 
combine the results of static analysis with a different set of loads such as dead loads, live loads, 
thermal loads, seismic loads, and so on. 

Introduction to Finite Element Analysis (FEA)
Finite element analysis (FEA) uses a numerical technique known as finite element method (FEM) to 
solve engineering problems. The finite element method (FEM) is the most widely used and accepted 
method to solve engineering problems involving stress analysis, deflections, reactions, vibrations, 
fluid flow, heat transfer, electrical, magnetic fields, and so on due its suitability, numerical efficiency, 
and generality for computer application. 

The whole concept of FEM can be explained with a small example of measuring the area of an 
unknown geometry of a plate, see Figure 1.1. There are many ways to measure the area of an unknown 
geometry, but the best way is to divide the entire geometry into different known geometries whose 
area can be easily calculated, see Figure 1.2. After measuring the area of each individual known 
geometry, assemble them together to get the total area of the geometry. 

1.1 1.2
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The same concept is used in FEM to calculate stresses, displacements, strains, reaction forces, 
temperature, frequency, vibrations, and so on of a complex structure. FEM divides the entire complex 
structure into a finite number of pieces of simple geometric shapes called elements, see Figure 1.3. It 
replaces a complex engineering problem with multiple simple problems that can be easily solved.

1.3

It is clear from the above figure that a FEM model consists of a number of finite elements which 
collectively represent the entire structure. Note that the geometries of the real-world mechanical 
structures are complex and to accurately represent their shapes, more number of finite elements 
are required due to which the computational time to calculate the response of all elements gets 
increased. Therefore, in finite element analysis (FEA), there needs to be proper balance between 
the accuracy of results and the computational time. This makes the finite element analysis (FEA) a  
suitable method for finding approximate solutions to the engineering problems.  

Working with Different Phases of FEA
Before you start performing an analysis, it is important to understand the different phases of finite 
element analysis (FEA). As discussed,  SOLIDWORKS Simulation is a finite element analysis (FEA) 
tool which uses a numerical technique known as finite element method (FEM) to solve engineering 
problems. In finite element analysis (FEA), the entire process of analyzing the engineering design is 
divided into three phases: Pre-processing, Solution, and Post-processing. The phases are discussed 
below. 

Pre-processing
The Pre-processing phase involves creating/importing CAD models, simplifying geometry, selecting 
analysis type, assigning material properties, defining boundary conditions (external loads and 
supports), and meshing the model, see Figure 1.4. 

Solution
The Solution phase is completely automatic in SOLIDWORKS Simulation. In this phase, the system 
generates matrices for individual finite elements, which are then assembled to generate a global matrix 
equation for the structure. Further, it solves the global matrix equation to compute displacement, 
which is then used to compute strain, stress, and reaction forces. Note that in this phase the computed 
results are stored in numerical form.  
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Post-processing
In the Post-processing phase, the results generated in the Solution phase appear in graphical form 
for checking or analyzing them, see Figure 1.4. You can also animate the structure response based 
on the results obtained in the Solution phase. The graphical representation of results is very useful 
in understanding the correct behavior of the structure.

1.4

Important Terms and Definitions used in FEA
Some of the important terms and definitions used in finite element analysis (FEA) are discussed 
below. 

Stress
Stress is defined as the force per unit area. When an object is subjected to an external force, the 
internal resistance offered by the object is known as stress.  
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    Ϭ = F/A

   Where,
    Ϭ = Stress
    F = External force acting on the object
    A = Cross sectional area of the object

Stress has various forms, but mainly categorized into three types: Tensile Stress, Compressive Stress, 
and Shear Stress, all of which are discussed below. 

Tensile Stress
When an object is subjected to tensile forces, the internal resistance applied by the object against 
the increase in its length is known as tensile stress, see Figure 1.5.

1.5

Compressive Stress
When an object is subjected to compressive forces, the internal resistance applied by the object 
against the decrease in its length is known as compressive stress, see Figure 1.6.

1.6

Shear Stress
Shear stress occurs when two objects tend to slide over one another due to the application of external 
forces which are parallel to the plane of shear, see Figure 1.7.

1.7
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Strain
Strain is defined as the ratio of change in length to the original length of the object when it undergoes 
deformation due to the application of an external force, see Figure 1.8.

1.8

   ε = dl/L

   Where,
     ε = Strain
    dl = Change in length of the object
     L = Original length of the object

Load
Load is defined as the external force acting on an object.

Displacement
Displacement is defined as the change in length or position of an object.

Hooke’s Law
Hooke’s Law defines that the ratio of stress to strain is constant. It states that stress is directly 
proportional to strain within the elastic region of the stress-strain curve of a material, when the 
material is subjected to an external load, see Figure 1.9.

   Constant = Stress (Ϭ) /Strain (ε) [within the elastic region] 

1.9
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Yield Strength
Yield strength is defined as the maximum stress (yield stress) up to which a material deforms elastically 
under the impact of an applied load and returns to its original configuration once the load is removed. 
It is also defined as the stress under which the material begins to deform plastically.

Ultimate Strength
Ultimate strength is defined as the maximum stress that a material can withstand when subjected to 
an external load. It is also defined as the stress beyond which the material begins to fail or weaken.

Fracture Strength
Fracture strength is defined as the breaking stress under which a material fails due to fracture or 
breakage. 

Young’s Modulus
Young’s modulus is also known as the modulus of elasticity or the elastic modulus, and defines the 
relationship between stress and strain of a material as per Hooke’s law. It measures the stiffness of 
a material.

    E = Stress (Ϭ) / Strain (ε)
    E = F*L / A*dl
    F = E*A*dl / L
    F = (E*A / L) * dl
    F = K * X

   Where,
    
    K = Stiffness (E*A / L)
    E = Young’s modulus
    A = Cross section area 
    L = Original length
    X = Change in length (dl)
    F = Applied force
    

Stiffness
Stiffness is defined as the property of a material which offers resistance against its deformation when 
it is subjected to an external force.

    K = F / dl 

   Where,
    
    K = Stiffness
    F = Applied external force
    dl = Displacement (change in length)
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Poisson’s Ratio
Poisson’s ratio is defined as the ratio of lateral strain to the axial or longitudinal strain of a material in 
the direction of the applied load, see Figure 1.10. The Poisson’s ratio of a material within the elastic 
limit is constant. This implies that the ratio of lateral strain to the axial or longitudinal strain of a 
material within the elastic limit is constant.

     μ = εlateral / εaxial

    Where,
     μ = Poisson’s ratio
     εlateral = Lateral strain
     εaxial = Axial or longitudinal strain

1.10

    Axial or Longitudinal strain (εaxial) = ΔL - L / L = dla / L
   Where,
    L = Initial/original length
    ΔL = Final length
    dla = Change in length in axial direction

    Lateral strain (εlateral) =  ΔD - D / D = dll / D 
   Where, 
    D = Initial/original width 
    ΔD = Final width
    dll = Change in width in lateral direction

Creep
Creep is defined as the tendency of a material to deform slowly or gradually. It increases with time 
under the impact of stress which is below the yield strength of the material, see Figure 1.11. It is a 
material property which depends on both stress and temperature. 
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Meshing
Meshing is defined as the process of dividing an object into a finite number of pieces with simple 
geometric shapes called elements, see Figure 1.12. 

1.12

Elements
Elements are small pieces of simple geometric shapes into which an object is divided while meshing. 
Elements are mainly categorized into three types: 1D elements, 2D elements, and 3D elements, see 
the table given below:

Element Type Element Shape

1D Element
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2D Element

3D Element
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Nodes
Elements are connected to each other at common points called nodes, see Figures 1.13 and 1.14. The 
nodes define the shape of elements. If you move a node of an element, the shape of the element 
will change depending on the new position of the node.  

1.141.13

Different Application Areas of FEA
The finite element analysis (FEA) was developed for the nuclear research, and aerospace industries. 
However, currently, it is a widely used and accepted method in all engineering disciplines (mechanical, 
civil, electrical, and automobile etc). The areas of applications of FEA include:

1. Structure analysis
2. Thermal analysis
3. Buckling analysis
4. Fluid flows analysis
5. Frequency analysis
6. Mould flow analysis
7. Drop test
8. Pressure vessel design
9. Fatigue analysis
10. Vibrations
11. Electromagnetic analysis
12. Biomechanics, and many more

Installing SOLIDWORKS Simulation
SOLIDWORKS Simulation is fully integrated with SOLIDWORKS, therefore to install SOLIDWORKS 
Simulation, you must have SOLIDWORKS installed on your system. If you do not have these softwares 
installed in your system, you first need to install them. However, before that, you need to evaluate 
the system requirements and ensure that you have a system capable of running SOLIDWORKS and 
SOLIDWORKS Simulation adequately. The system requirements for installing the same are listed 
below:

1.  Operating Systems: Windows 10 - 64-bit
2.  RAM: 8 GB or more (16 GB or more recommended)
3.  Disk Space: 10 GB or more
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4.  Processor: 3.3 GHz or higher
5.  Graphics Card: SOLIDWORKS certified graphics card drivers

For more information about the system requirements for SOLIDWORKS, visit the SOLIDWORKS 
website at https://www.solidworks.com/sw/support/SystemRequirements.html

Getting Started with SOLIDWORKS Simulation
Once SOLIDWORKS 2021 and SOLIDWORKS Simulation 2021 are installed on your system, start by 
double-clicking on the SOLIDWORKS 2021 icon on your desktop. The system prepares for starting 
SOLIDWORKS and SOLIDWORKS Simulation by loading all required files. Once all the required 
files have been loaded, the initial screen of SOLIDWORKS 2021 appears along with a Welcome 
dialog box, see Figure 1.15. If you are starting SOLIDWORKS for the first time after installing the 
software, the SOLIDWORKS License Agreement window appears. Click on the Accept button 
in the SOLIDWORKS License Agreement window to accept the license agreement and start 
SOLIDWORKS.

1.15

In SOLIDWORKS 2021, the Welcome dialog box appears every time you start SOLIDWORKS and is 
a convenient way to invoke new SOLIDWORKS documents, open existing documents, view recent 
documents and folders, access SOLIDWORKS resources, and stay updated on SOLIDWORKS 
news.

The Welcome dialog box has four tabs: Home, Recent, Learn, and Alerts. The options in the Home 
tab are used for invoking new SOLIDWORKS documents, opening existing documents, viewing recent 
documents and folders, and accessing SOLIDWORKS resources. The Recent tab displays a longer 
list of recent documents and folders. The Learn tab is used for accessing instructional resources such 
as tutorials, sample models, access to 3D Content Center, certification program, and so on, to help 
you learn more about SOLIDWORKS. The Alerts tab is used for updating you with SOLIDWORKS 
news and providing different types of alerts in different sections including Troubleshooting and 
Technical Alerts.
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on the Welcome to SOLIDWORKS tool  in the Standard toolbar or by pressing the 
CTRL + F2 keys. Alternatively, you can click on Help > Welcome to SOLIDWORKS in the 
SOLIDWORKS Menus or the Welcome to SOLIDWORKS option in the SOLIDWORKS 
Resources Task Pane to invoke the Welcome dialog box. You will learn more about Standard 
toolbar, SOLIDWORKS Menus, and Task Pane later in this chapter.

Note that SOLIDWORKS Simulation can be invoked within the Part modeling and Assembly 
environments of SOLIDWORKS, therefore, it is important to get familiar with different environments 
of SOLIDWORKS. The methods for invoking different environments of SOLIDWORKS are discussed 
below. 

Invoking the Part Modeling Environment  
The Part modeling environment is used for creating 3D solid models, surface models, and sheet metal 
models. Further, you can access SOLIDWORKS Simulation within the Part modeling environment 
of SOLIDWORKS to perform finite element analysis (FEA) on a part/component. To invoke the Part 
modeling environment, click on the Part button in the Welcome dialog box. The Part modeling 
environment gets invoked and the initial screen of the Part modeling environment appears, as shown 
in Figure 1.16. Alternatively, to invoke the Part modeling environment, click on the New tool  in the 
Standard toolbar. A New SOLIDWORKS Document dialog box appears, see Figure 1.17. In this dialog 
box, make sure that the Part button is activated and then click on the OK button.  You will learn how 
to invoke SOLIDWORKS Simulation within the Part modeling environment later in this chapter.

1.16

 Note:  If you are invoking the Part modeling environment for the first time after installing the 
software, the Units and Dimension Standard dialog box appears, see Figure 1.18. You can 
specify the unit system as the default unit system for SOLIDWORKS by using this dialog 
box. 
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1.18

It is evident from the initial screen of the Part modeling environment that SOLIDWORKS is very 
user-friendly and easy to operate. Some of the components of the initial screen are discussed below. 

Standard Toolbar 
The Standard toolbar contains a set of the most frequently used tools such as New, Open, and Save, 
see Figure 1.19. 

1.19
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SOLIDWORKS Menus 
The SOLIDWORKS Menus contain different menus such as File, View, and Tools for accessing 
different tools of SOLIDWORKS, see Figure 1.20. 

1.20

Note that the SOLIDWORKS Menus appear when you move the cursor over the SOLIDWORKS logo, 
which is available at the top left corner of the screen. You can keep the SOLIDWORKS Menus visible 
all the time by clicking on the push-pin button  available at the end of the SOLIDWORKS Menus. 
Note that the tools in different menus are dependent upon the type of environment invoked.  

SOLIDWORKS Search 
The SOLIDWORKS Search is a search tool for searching commands, tools, knowledge database 
(help topics), community forum, files, models, and so on, see Figure 1.21.

1.21

CommandManager
CommandManager is available at the top of the graphics area. It provides access to different 
SOLIDWORKS tools. There are various CommandManagers such as Features CommandManager, 
Sketch CommandManager, Evaluate CommandManager, and so on, which are available in the Part 
modeling environment. When the Features tab is activated in the CommandManager, the Features 
CommandManager appears, which provides access to different tools for creating 3D solid models, 
see Figure 1.22. On clicking on the Sketch tab, the Sketch CommandManager appears, which provides 
access to different tools for creating sketches. 

1.22

Note that tabs of some of the CommandManagers such as Surfaces CommandManager and Sheet 
Metal CommandManager are not available in the CommandManager by default. You will learn about 
adding these tabs later in this chapter. 

 Note:  Different environments (Part, Assembly, and Drawing) of SOLIDWORKS are provided 
with different sets of CommandManagers. 

FeatureManager Design Tree
FeatureManager Design Tree appears on the left side of the graphics area and keeps a record of all 
operations or features used for creating a model, see Figure 1.23. Note that the first created feature 
appears at the top and the following created features appear one after the other in the order of 
creation in the FeatureManager Design Tree. Also, in the FeatureManager Design Tree, three default 
planes and an origin appear by default, see Figure 1.23.
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 Tip:   Features are logical operations that are performed to create a component. In other words, 
a component can be designed by creating a number of features such as extrude, sweep, 
hole, fillet, draft, and so on.

View (Heads-Up) Toolbar
The View (Heads-Up) toolbar is available at the top center of the graphics area, see Figure 1.24. It is 
provided with different sets of tools that are used for manipulating the view and display of a model 
available in the graphics area.

1.24

Status Bar
The Status Bar is available at the bottom of the graphics area and provides information about the 
action to be taken based on the currently active tool. It also displays the current state of a sketch 
being created, coordinate system, and so on. 

Task Pane
Task Pane appears on the right side of the screen with various tabs such as SOLIDWORKS Resources, 
Design Library, File Explorer, View Palette, Appearances, Scenes, and Decals, Custom Properties, 
and 3DEXPERIENCE Marketplace for accessing various online resources of SOLIDWORKS, several 
applications, subscription services, library, and so on, see Figure 1.25. 
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Invoking the Assembly Environment  
The Assembly environment is used for assembling different components of an assembly with respect 
to each other by applying the required mates, see Figure 1.26. Further, you can access SOLIDWORKS 
Simulation within the Assembly environment to perform finite element analysis (FEA) on an assembly 
or assembly components. To invoke the Assembly environment, click on the Assembly button in 
the Welcome dialog box. The Assembly environment is invoked with the display of the Open dialog 
box along with the Begin Assembly PropertyManager, see Figure 1.27. You will learn how to invoke 
SOLIDWORKS Simulation within the Assembly environment later in this chapter. 

1.26
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Alternatively, to invoke the Assembly environment, click on the New tool  in the Standard toolbar. 
A New SOLIDWORKS Document dialog box appears. In this dialog box, click on the Assembly 
button and then click on the OK button. 

Invoking the Drawing Environment  
The Drawing environment of SOLIDWORKS is used for creating 2D drawings of a part or an assembly, 
see Figure 1.28. To invoke the Drawing environment, click on the New tool in the Standard toolbar. 
A New SOLIDWORKS Document dialog box appears. In this dialog box, click on the Drawing 
button and then click on the OK button. The Sheet Format/Size dialog box appears. The options 
in this dialog box are used for selecting sheet size/format to be used for creating drawings. You can 
also invoke the Sheet Format/Size dialog box by clicking on the Drawing button in the Welcome 
dialog box. Once you have defined sheet size and format in the Sheet Format/Size dialog box, click 
on the OK button. The initial screen of the Drawing environment appears with the display of the 
Model View PropertyManager on the left of the drawing sheet, see Figure 1.29. The Model View 
PropertyManager is used for inserting a component or an assembly into the Drawing environment 
to create its drawing views.

1.28
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Identifying SOLIDWORKS Documents
The documents created in different environments (Part, Assembly, and Drawing) of SOLIDWORKS 
have a different file extension, see the table given below:

Environments File Extension
Part Modeling Environment *.sldprt
Assembly Modeling Environment *.sldasm  
Drawing Modeling Environment *.slddrw 

Adding CommandManager Tabs
In addition to the default CommandManagers such as Features CommandManager and Sketch 
CommandManager, you can also add additional CommandManagers that are not available by default. 
To add a CommandManager, right-click on any of the available CommandManager tabs. A shortcut 
menu appears. In this shortcut menu, move the cursor over the Tabs option. A cascading menu 
appears, see Figure 1.30. This cascading menu displays a list of the available CommandManagers. 
A tick-mark in front of the CommandManager indicates that the respective CommandManager 
is already added. Click on the required CommandManager in the cascading menu, the respective 
CommandManager tab gets added to the CommandManager. 
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Invoking SOLIDWORKS Simulation
SOLIDWORKS Simulation can be invoked within the Part modeling and Assembly environments of 
SOLIDWORKS to perform various types of finite element analysis (FEA). To start SOLIDWORKS 
Simulation, click on the Tools > Add-Ins in the SOLIDWORKS Menus, see Figure 1.31. The Add-Ins 
dialog box appears, see Figure 1.32.

1.31
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the arrow at its bottom to display the Add-Ins tool as shown in Figure 1.31. 

1.32

In the Add-Ins dialog box, click on the check boxes available on the left and right of the SOLIDWORKS 
Simulation option, see Figure 1.32. Next, click on the OK button. SOLIDWORKS Simulation is 
invoked and the Simulation menu gets added to the SOLIDWORKS Menus, see Figure 1.33. Also, 
the Simulation tab gets added to the CommandManager, see Figure 1.33. The Simulation menu and 
Simulation tab are provided with different sets of simulation tools to perform various types of finite 
element analysis (FEA). 

1.33
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If the Simulation tab is not added in the CommandManager by default, then you need to add it 
manually. For doing so, right-click on any of the tabs of the CommandManager. A shortcut menu 
appears. In this shortcut menu, move the cursor over the Tabs options and then click on the Simulation 
option in the cascading menu that appears. Alternatively, click on the SOLIDWORKS Add-Ins tab 
in the CommandManager to display the tools of the SOLIDWORKS Add-Ins CommandManager, 
see Figure 1.34. Next, click on the SOLIDWORKS Simulation tool.

1.34

 NOTE  If you select the check box available to the right of the SOLIDWORKS Simulation option 
in the Add-Ins dialog box then SOLIDWORKS Simulation will be invoked every time on 
starting SOLIDWORKS, automatically. However, if you select the check box available 
to the left of the SOLIDWORKS Simulation option then SOLIDWORKS Simulation will 
be invoked only for the current session of the SOLIDWORKS. To invoke SOLIDWORKS 
Simulation for the current SOLIDWORKS session as well as for every session of 
SOLIDWORKS, you need to select both these check boxes in the Add-Ins dialog box.     

If the SOLIDWORKS Simulation option is not available in the Add-Ins dialog box then 
you first need to install SOLIDWORKS Simulation.

After invoking SOLIDWORKS Simulation, click on the Simulation tab in the CommandManager. 
The Simulation CommandManager appears, see Figure 1.35. It contains tools to perform various 
types of finite element analysis (FEA). Note that initially, most of the tools of the Simulation 
CommandManager are not enabled. These tools will get enabled only after defining the type of finite 
element analysis (FEA) to be performed. You can define the type of analysis by using the New Study 
tool of the Simulation CommandManager.          

1.35
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Note that before you define the type of analysis to be performed by using the New Study tool, you 
need to create or import a geometry in SOLIDWORKS to perform the analysis on it. You will learn 
about performing different types of analysis in the later chapters. 

Summary
This chapter provided an introduction to SOLIDWORKS Simulation, various types of 
analysis, introduction to finite element analysis (FEA), and different phases of finite element 
analysis (FEA): Pre-processing, Solution, and Post-processing. It explained various terms and 
definitions used in finite element analysis (FEA). The chapter also discussed different types of 
elements, the application areas of FEA, system requirements for installing SOLIDWORKS Simulation, 
and SOLIDWORKS interface, invoking different SOLIDWORKS documents and getting started  
with SOLIDWORKS Simulation.  

Questions
• In the linear static analysis, the material properties of an object are assumed to behave 

________ under the impact of applied load. 

• The ________ analysis is used for calculating the natural or resonant frequencies and the 
associated mode shapes of a structure.

• The ________ analysis is used for calculating the stress at which an object fails, when it 
undergoes repeated loading and unloading process.

• The finite element analysis (FEA) uses a numerical technique known as ________ to solve 
engineering problems.

• In finite element analysis (FEA), the entire process of analyzing the engineering design is divided 
into three phases ________, ________, and ________.

• ________ is defined as the process of dividing an object into a finite number of pieces with 
simple geometric shapes called elements.

• The elements are mainly categorized into ________, ________, and ________.

• ________ strength is defined as the maximum stress that a material can withstand when 
subjected to an external load.

• ________ is defined as the ratio of change in length to the original length of the object when 
it undergoes deformation due to the application of external load.
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• ________ strength is defined as the maximum stress up to which a material deforms 

elastically under the impact of applied load and returns to its original configuration once the 
load is removed.

• ________ is defined as the property of a material which offers resistance against the 
deformation of the material when it is subjected to an external force.


